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SOFTWARE LICENSE AGREEMENT

IMPORTANT: BY OPENING THE SEALED DISK PACKAGE CONTAINING THE SOFT-
WARE MEDIA, YOU ARE AGREEING TO BE BOUND BY THE TERMS AND CONDI-
TIONS OF THE LICENSE AGREEMENT (“AGREEMENT”).  THIS AGREEMENT 
CONSTITUTES THE COMPLETE AGREEMENT BETWEEN YOU (“LICENSEE”) AND 
THALES NAVIGATION (“LICENSOR”).  CAREFULLY READ THE AGREEMENT 
AND IF YOU DO NOT AGREE WITH THE TERMS, RETURN THIS UNOPENED DISK 
PACKAGE AND THE ACCOMPANYING ITEMS TO THE PLACE WHERE YOU OB-
TAINED THEM FOR A FULL REFUND.

LICENSE.  LICENSOR grants to you a limited, non-exclusive, non-transferable, personal
cense (“License”) to (i) install and operate the copy of the computer program contained in
package (“Program”) in machine acceptable form only on a single computer (one central 
processing unit and associated monitor and keyboard) and (ii) make one archival copy of
Program for use with the same computer.  LICENSOR and its third-party suppliers retain
rights to the Program not expressly granted in this Agreement.

OWNERSHIP OF PROGRAMS AND COPIES.  This License is not a sale of the original 
Program or any copies.  LICENSOR and its third-party suppliers retain the ownership of t
Program and all copyrights and other proprietary rights therein, and all subsequent copies
Program made by you, regardless of the form in which the copies may exist.  The Program
the accompanying manuals (“Documentation”) are copyrighted works of authorship and co
valuable trade secrets and confidential information proprietary to LICENSOR and its third-p
suppliers.  You agree to exercise reasonable efforts to protect the proprietary interests of
LICENSOR and its third-party suppliers in the Program and Documentation and maintain 
in strict confidence.

USER RESTRICTIONS.  The Program is provided for use in your internal commercial busi
operations and must remain at all times upon a single computer owned or leased by you.
may physically transfer the Program from one computer to another provided that the Progr
operated only on one computer at a time.  You may not operate the Program in a time-sha
service bureau operation or rent, lease, sublease, sell, assign, pledge, transfer, transmit 
electronically or otherwise dispose of the Program or Documentation, on a temporary or 
permanent basis, without the prior written consent of LICENSOR.  You agree not to trans
modify, adapt, disassemble, decompile, or reverse engineer the Program, or create deriv
works of the Program or Documentation or any portion thereof.

TERMINATION.  The License is effective until terminated.  The License will terminate witho
notice from LICENSOR if you fail to comply with any provisions of this Agreement.  Upon
termination, you must cease all use of the Program and Documentation and return them, a
copies thereof, to LICENSOR.

GENERAL.  This Agreement shall be governed by and construed in accordance with the 
of the State of California and the United States without regard to conflict of laws provision
thereof and without regard to the United Nations Convention on Contracts for the Internat
Sale of Goods.
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DISCLAIMER OF WARRANTIES AND LIMITATION OF LIABILITY

LICENSOR AND ITS THIRD-PARTY SUPPLIERS MAKE NO WARRANTIES OR 
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING THE PROGRAM, 
MEDIA, DOCUMENTATION, RESULTS OR ACCURACY OF DATA AND 
HEREBY EXPRESSLY DISCLAIM ANY WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT.  LICENSOR AND ITS THIRD-PARTY SUPPLIERS DO 
NOT WARRANT THE PROGRAM WILL MEET YOUR REQUIREMENTS OR 
THAT ITS OPERATION WILL BE UNINTERRUPTED OR ERROR-FREE.

LICENSOR, its third-party suppliers, or anyone involved in the creation or delivery of 
the Program or Documentation to you shall have no liability to you or any third-party 
for special, incidental, indirect or consequential damages (including, but not limited 
to, loss of profits or savings, downtime, damage to or replacement of equipment or 
property, or recovery or replacement of programs or data) arising from claims based 
in warranty, contract, tort (including negligence), strict liability, or otherwise even if 
LICENSOR or its third-party suppliers have been advised of the possibility of such 
claim or damages.  The liability of LICENSOR and its third-party suppliers for direct 
damages shall not exceed the actual amount paid for this Program License.

Some states do not allow the exclusion of limitation of implied warranties or liability 
for incidental or consequential damages, so the above limitations or exclusions may 
not apply to you.

U.S. GOVERNMENT RESTRICTED RIGHTS

The Program and Documentation are provided with RESTRICTIVE RIGHTS.  Use, duplication, 
or disclosure by the Government is subject to restrictions as set forth in subdivision (c)(1)(ii) of 
the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or 
subdivision 9(C)(1) and (2) of the Commercial Computer Software - Restricted Rights 48 CFR 
52.227.19, as applicable.

Should you have any questions concerning the License Agreement or the Limited Warranties 
and Limitation of Liability, please contact in writing:  Thales Navigation, 471 El Camino Real,
Santa Clara, CA, 95050, USA.
Receiver Communication Software User’s Guide



Table of Contents
Table of Co

R
eliance F

undam
entals
Chapter 1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
RCS Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Commander . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Download  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Handheld Transfer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Radio Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
RINEX Converter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Frequently Asked Questions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Installation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Using On-line Help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Chapter 2. Commander . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Starting Commander  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Connecting to a Receiver . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Auto-Connection at StartUp . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
Connecting to a Receiver From the Main Window. . . . . . . . . . . . . . . . . . . . 7

Direct Connect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Remote Connect . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9
Entering a New Phone Number . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11
Setting Advanced Modem Features . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Using the Options Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Log File Tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Send Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Check Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19
Misc Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20

Disconnecting From a Receiver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Getting Around in Commander . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Setting Up a Receiver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22

Saving Parameter Script Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Opening an Existing Script File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
Loading Receiver Parameters From a Receiver  . . . . . . . . . . . . . . . . . . . . . 26

Survey Applications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
Receiver Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28

Receiver Information . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Using the Terminal Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Communicating with the Receiver  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
ntents  v



vi
Command History  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  31
Copying and Pasting Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32
Customizing the Terminal Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  32

Logging Receiver Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34
Menus and Toolbar . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Chapter 3. Uploading Firmware and Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

Chapter 4. Download . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Starting Download  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
Transferring Data - Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Transferring Data Directly from the Receiver . . . . . . . . . . . . . . . . . . . . . .  42
Transferring Data from PCMCIA Card in a Local Drive. . . . . . . . . . . . . .  43

Chapter 5. Handheld Transfer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Before Using Handheld Transfer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
FS/2 or FS/3 Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
Workabout Setup. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Using Handheld Transfer  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Operation  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Switching Between Panes. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  47
Connecting a Handheld  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  48

Connect Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
Auto Connect Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Viewing a List of Files and Directories . . . . . . . . . . . . . . . . . . . . . . . . . . .  48
Selecting a Drive  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49
Copying and Moving Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  49

Chapter 6. Radio Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Pacific Crest UHF/VHF Radio Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
Connecting to a Pacific Crest Radio. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  52

Chapter 7. RINEX Converter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Preliminary Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 55
Starting RINEX Converter . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
Converting RINEX to Ashtech Format  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 58
Converting Ashtech Files to RINEX Format  . . . . . . . . . . . . . . . . . . . . . . . . . . 61

Appendix A. File Structures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1

Names Convention  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-2

A-File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-2
Receiver Communication Software User’s Guide



Table of Co
B-File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-2
C-File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-3
D-File  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-3
E-File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-3
M-File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-3
S-File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  A-3

 Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Index-1
ntents vii



viii
 Receiver Communication Software User’s Guide



List of Figures
List of Figu

R
eliance F

undam
entals
 Figure 2.1: StartUp Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
 Figure 2.2: Direct Connection Dialog Box - Select Port Tab . . . . . . . . . . . . . . 8
 Figure 2.3: Direct Connection Dialog Box - Settings Tab  . . . . . . . . . . . . . . . . 8
 Figure 2.4: Remote Connection Dialog Box - Select Port Tab . . . . . . . . . . . . 10
 Figure 2.5: Remote Connection Dialog Box - Select Phone Number Tab . . . 10
 Figure 2.6: Dial Entry Settings Dialog Box - Dial Entry Tab. . . . . . . . . . . . . 12
 Figure 2.7: Settings Dialog Box - Settings Tab. . . . . . . . . . . . . . . . . . . . . . . . 12
 Figure 2.8: Advanced Modem Settings Dialog Box - Modem Tab  . . . . . . . . 13
 Figure 2.9: Advanced Modem Settings Dialog Box - Work Mode Tab . . . . . 14
 Figure 2.10: Advanced Modem Settings Dialog Box - Modem Mode Tab  . . . 15
 Figure 2.11: Options Dialog Box - Log File Tab  . . . . . . . . . . . . . . . . . . . . . . . 16
 Figure 2.12: Options Dialog Box Send Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . 18
 Figure 2.13: Options Dialog Box Check Tab . . . . . . . . . . . . . . . . . . . . . . . . . . 19
 Figure 2.14: Options Dialog Box Misc. Tab . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
 Figure 2.15: Commands Menu Structure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
 Figure 2.16: Typical Survey Application Window . . . . . . . . . . . . . . . . . . . . . . 22
 Figure 2.17: Recording Tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23
 Figure 2.18: Terminal Window with Command and Response Messages . . . . 24
 Figure 2.19: Commander Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
 Figure 2.20: Typical Receiver Setup Survey Application Window . . . . . . . . . 29
 Figure 2.21: Receiver Info Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
 Figure 2.22: Terminal Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
 Figure 2.23: Terminal Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
 Figure 3.2: Typical File Selection Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . 40
 Figure 4.1: Download Main Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41
 Figure 5.1: FS/2 or FS/3 Power Parameters Screen  . . . . . . . . . . . . . . . . . . . . 45
 Figure 5.2: Handheld Transfer Main Window  . . . . . . . . . . . . . . . . . . . . . . . . 47
 Figure 5.3: Connect to Handheld Dialog Box. . . . . . . . . . . . . . . . . . . . . . . . . 48
 Figure 6.1: Utilities Window. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51
 Figure 6.2: UHF-VHF Radio Setup Main Window  . . . . . . . . . . . . . . . . . . . . 52
 Figure 6.3: UHF-VHF Radio Setup Main Window - Connected . . . . . . . . . . 53
 Figure 7.1: RINEX-to-Ashtech Tab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56
 Figure 7.3: Set Input Directory Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . 58
 Figure 7.4: RINEX-to-Ashtech Tab with Suggested Output File Names . . . . 59
 Figure 7.5: Set Output Directory Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . 59
 Figure 7.6: Conversion Status Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . 60
 Figure 7.7: Ashtech to RINEX Tab. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 61
 Figure 7.9: Set Input Directory Dialog Box  . . . . . . . . . . . . . . . . . . . . . . . . . . 63
res  ix



x

 Figure 7.10: Ashtech Files in Selected Ashtech Input Directory . . . . . . . . . . . 64
 Figure 7.11: Set Output Directory Dialog Box. . . . . . . . . . . . . . . . . . . . . . . . . 65
 Figure 7.12: Additional Info for Selected Files Dialog Box- OBS Tab . . . . . . 66
 Figure 7.14: Additional Info for Selected Files Dialog Box - NAV Tab . . . . . 68
 Figure 7.16: Additional Info for Selected Files Dialog Box - MET Tab . . . . . 69
 Figure 7.18: Edit Dialog Box . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
 Figure 7.20: Conversion Status Dialog. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71
 Figure A.1: File Naming Convention . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . A-1
Receiver Communication Software User’s Guide



List of Tables
List of Tab

R
eliance F

undam
entals
 Table 1.1: Equipment Supported by RCS . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
 Table 1.2: Common RCS Operations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
 Table 2.1: Startup Dialog Box Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
 Table 2.2: Communication Parameter Options . . . . . . . . . . . . . . . . . . . . . . . . 9
 Table 2.3: Components of the Select Phone Number Tab. . . . . . . . . . . . . . . 10
 Table 2.4: Advanced Modem Settings - Modem Tab . . . . . . . . . . . . . . . . . . 14
 Table 2.5: Advanced Modem Settings Dialog Box - Work Mode Tab . . . . . 14
 Table 2.6: Advanced Modem Settings Dialog Box - Modem Mode Tab  . . . 15
 Table 2.7: Log File Tab Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
 Table 2.8: Options Dialog Box Send Tab Options  . . . . . . . . . . . . . . . . . . . . 18
 Table 2.9: Options Dialog Box Check Tab . . . . . . . . . . . . . . . . . . . . . . . . . . 19
 Table 2.10: Elements of a Survey Application Window . . . . . . . . . . . . . . . . . 22
 Table 2.11: Survey Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
 Table 2.12: Receiver Command Functional Groups . . . . . . . . . . . . . . . . . . . . 28
 Table 2.13: Terminal Pop-Up Menu Options  . . . . . . . . . . . . . . . . . . . . . . . . . 33
 Table 2.14: Commander Menu System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
 Table 2.15: Commander Toolbar Buttons . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38
 Table 3.1: Firmware and Options Identification . . . . . . . . . . . . . . . . . . . . . . 39
 Table 7.2: RINEX to Ashtech Tab Parameters  . . . . . . . . . . . . . . . . . . . . . . . 56
 Table 7.8: Ashtech to RINEX Tab Fields  . . . . . . . . . . . . . . . . . . . . . . . . . . . 62
 Table 7.13: Additional Info for Selected Files Dialog Box - OBS Tab. . . . . . 66
 Table 7.15: Additional Info for Selected Files Dialog Box - NAV Tab . . . . . 68
 Table 7.17: Additional Info for Selected Files Dialog Box - MET Tab  . . . . . 69
 Table 7.19:  Edit Dialog Box Parameters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70
 Table A.1: Explanation of File Name BBASEA97.059 . . . . . . . . . . . . . . . . A-2
les  xi



xii
 Receiver Communication Software User’s Guide



 1

Introduc
Introduction
Introductio

tion

e 

ws 
not 

 
nds, 

p 
Overview

Receiver Communications Software™ (RCS) is a set of user-friendly utilities that mak
it easy to set up, communicate with, and transfer data between the receivers and 
equipment listed in Table 1.1. RCS runs under Windows 95, Windows 98, and Windo
NT 4.0. RCS may work with receivers from other manufacturers, but compatibility is 
assured.       

RCS Applications

RCS includes the following applications:

Commander

Commander lets you quickly and easily configure a receiver for a variety of surveying
applications. Using a standard Windows interface, you can select serial port comma
set the required parameters, and send the commands to a receiver. Commander replaces 
Remote™ for local receiver control. Commander stores frequently-used receiver setu

 Table 1.1: Equipment Supported by RCS 

Equipment

ASHTECH RECEIVERS

Z-Surveyor - 12-channel dual-frequency GPS  receiver 

Z-12 - 12-channel dual-frequency GPS receiver

Z-12 with RTK

GG24 (GG Surveyor) - 24-channel GPS+GLONASS receiver for difficult reception environments

SCA-12 - 12-channel single-frequency GPS receiver

OTHER EQUIPMENT

Husky FS/2 and FS/3 handheld controller

Psion Workabout handheld controller

Pacific Crest RFM96 Series - UHF radio for data link communication

Ashtech SSRadio - UHF radio for data link communication
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configurations for easy recall. Commander includes features to upgrade receiver 
firmware and adds receiver options, and interact between several programs and the 
GPS receiver through the same COM port.

Download

Use Download to manage files on the receiver and transfer GPS data from a receiver 
via the COM port or modem to your PC hard drive. Because the receiver stores data 
in a compressed format, Download automatically converts the data for future use. 
The batch allows you to download more than one file at a time. 

Handheld Transfer

Handheld Transfer transfers files between a handheld controller (either the FS/2, 
FS/3, or Workabout) and a PC.

Radio Setup

Use Radio Setup to set the parameters in the data link radio (Ashtech SSRadio or 
Pacific Crest 96 Series)

RINEX Converter

RINEX Converter converts RINEX files to Ashtech format and Ashtech files to 
RINEX format. The batch mode allows multiple files to be converted with one 
command. 

Frequently Asked Questions

Table 1.2 lists some common and frequently used operations you can perform with 
RCS.  

 Table 1.2: Common RCS Operations

How do I.... Refer to Page

Connect a PC to a GPS receiver? Connecting to a receiver 14

Configure a radio modem for use in real-time survey applications Remote connect 20

Configure a GPS receiver? Setting up 35

Read the configuration of a receiver Load parameters 39

Update firmware/options in a GPS receiver? Upload 39

Download data from GPS receiver to PC for post-processing? Download 41
Receiver Communication Software User’s Guide



Introductio

Introduction
Installation

1. Start Windows. Close all active applications

2. Insert the RCS Disk 1 into your floppy drive.

3. Click the Start button, and select Run.

4. Type A:\setup and click OK.

If the floppy drive is not A, use the appropriate letter in its place.

5. Follow the on-screen instructions.

Be sure to read the License Agreement; by installing RCS, you agree to the 
terms in the License Agreement. 

6. You must restart your computer before using RCS for the first time.

Using On-line Help 

Any time you want to access the on-line help while using RCS, select Help Topics 
from the Help menu. The on-line Help system is more thorough than this manual, and 
is context sensitive. 

The on-line Help system is a point-and-click reference tool, with information about 
each entry field, dialog box, or listbox on each of the windows in RCS. It also has 
brief explanations about common procedures.

To see reference information on any screen, press [F1]. Many screens have a Help 
button that directly opens the on-line Help system.

Transfer files between handheld controller and PC? Handheld Transfer 45

Convert a RINEX file to Ashtech format or Ashtech to RINEX? RINEX Converter 55

 Table 1.2: Common RCS Operations

How do I.... Refer to Page
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Overview

Commander™ provides a quick and easy way to save and recall script files, and retrieve 
the receiver status. 

Receiver commands are organized by function, by survey application, and also by name. 
Ready-to-use survey applications let you easily set up your receiver for common post-
processed or real-time surveys. Commander makes it unnecessary to type cryptic serial 
port commands.

You can save a series of parameters into a script file and recall the file so that multiple 
receivers can be configured identically. These scripts are compatible with the Survey 
Control Software Suite, to configure receivers in the field with various Husky and Psion 
handheld controllers.

The Terminal  window displays the dialog between Commander and the receiver. If you 
wish, you can manually send Set ($PASHS) and Query ($PASHQ) commands from the 
Terminal  window.

Commander can log standard NMEA messages as well as binary raw data messages from 
the receiver into a log file for later analysis.

Commander supports PC COM ports 1 through 4 at baud rates of up to 115,200. The 
checksums of received messages are automatically verified and automatically appended to 
outgoing commands, ensuring the highest confidence in serial port communications.

Starting Commander 

Before using Commander, make sure that the receiver is turned on and connected to a serial port on your 
computer.

To start Commander, select the Commander icon  in the Receiver 
Communication menu in the Programs menu of the Start menu.
er  5
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Connecting to a Receiver

Commander provides two methods to connect to a receiver: 

1. Auto-connection at start-up 

2. Custom configuration from main menu 

Auto-Connection at StartUp

After starting Commander, the StartUp dialog box opens, Figure 2.1.     

Use the StartUp dialog to connect to a receiver with the same communication 
parameters as the last connection, set communication parameters and connect, or just 
start Commander without connecting to a receiver. Table 2.1 describes the options in 
the StartUp dialog box.

 Figure 2.1: StartUp Dialog Box

 Table 2.1: Startup Dialog Box Options

Option Description

Receiver drop down listbox Select the receiver type by clicking the arrow and selecting a 
receiver from the list presented. Only the Z-Surveyor receiver is 
available in Version 1.0.

Display this dialog box on next 
startup checkbox

A check in this box indicates that the Commander Startup Menu 
dialog box opens when Commander starts. 

Connection Options

Connect to GPS Receiver Click this radio button to connect to the specified receiver. The 
Communications window opens to set communication 
parameters and connect to the receiver.
Receiver Communication Software User’s Guide
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1. Click the arrow to the right of the GPS Receiver drop down listbox, and 
select the receiver from the list presented.

The list includes the most common receivers (GG24, SCA-12, Z-12, Z-
Surveyor), and a category Unknown. Use Unknown to configure other 
receivers not listed, and possibly some receivers from other manufacturers, 
although this function is not assured.

After selecting a receiver from this list, Commander displays only the 
commands applicable for that receiver.

2. Select the connection option, and click OK.

3. Commander connects to the receiver and the Commander main window 
opens.

Connecting to a Receiver From the Main Window

From the Commander main window, you can connect to a receiver via the Connect 
menu. 

The Connect menu has two connection options: Direct Connect and Remote 
Connect. 

Direct Connect

Use Direct Connect if your receiver is attached via a serial port to your PC. 

Connect to GPS Receiver with 
last settings

Click this radio button to connect to the selected receiver with the 
communication parameters used in the previous Commander 
session.

Start without connection Click this radio button to start Commander without connecting to 
a receiver. Later in the session, you can connect to the specified 
receiver. Use this option to setup and save receiver parameters and 
later load them to a receiver, or to create and save a script file to 
use with a portable computer when programming receivers.

 Table 2.1: Startup Dialog Box Options (continued)

Option Description
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1. After selecting Direct Connect, the Direct Connection dialog box (Figure 
2.2) opens.

2. In Select Port tab, select the COM port the receiver is attached. 

3. Click the Settings tab to switch to the Settings tab (Figure 2.3) and set the 
communication parameter options listed in Table 2.2.   

 Figure 2.2: Direct Connection Dialog Box - Select Port Tab

 Figure 2.3: Direct Connection Dialog Box - Settings Tab
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4. Select the parameters you want to use, and click OK. 

The Terminal window opens displaying the $PASH set and query 
commands while Commander attempts to connect to the receiver.

5. Connects to the receiver, and a dialog box opens indicating the connection is 
complete. Click OK.

6. The Terminal window closes automatically. 

Remote Connect

Remote Connect lets you connect your computer to a receiver out in the field via 
modem. In order to do this, your computer must be connected to the modem as 
specified in the applicable modem manual. 

1. Select Remote Connect from the Connect menu. 

 Table 2.2: Communication Parameter Options

Parameter Options

Baud rate 2400 38400
4800 57600
9600 115200
19200 Default is 38400.

Word length 5, 6, 7, or 8 bits. Default is 8.

Parity Even, none, mark, space. Default is none.

Stop bit 1 or 2 bits. Default is 1.

Use DTR/DSR
(Data Terminal Ready/Data Set 
Ready)

Standard RS-232 protocol. “Use” means that the serial 
interface uses this line in the serial connection to the 
receiver. Default is Off. 

Use RTS/CTS
(Ready To Send/Clear To Send)

Standard RS-232 protocol. “Use” means that the serial 
interface uses this line in the serial connection to the 
receiver. Default is Off.

Use XON/XOFF
Software handshake 

Standard RS-232 protocol. “Use” means that the serial 
interface uses this line in the serial connection to the 
receiver. Default is Off. 
er  9
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The Remote Connection dialog box opens (Figure 2.4).       

2. In the Select Port tab, select the COM port the modem is attached. 

3. Switch to the Select Phone Number tab (Figure 2.5).       

Table 2.3 describes the components in this dialog box.     

 Figure 2.4: Remote Connection Dialog Box - Select Port Tab

 Figure 2.5: Remote Connection Dialog Box - Select Phone Number Tab

 Table 2.3: Components of the Select Phone Number Tab

Component Description

Select a number to dial This panel displays all numbers that have been added. 

Add button Use this button open the Dial Entry Settings dialog box.
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4. Select a number to dial.

See “Entering a New Phone Number” on page 11 for more information o
adding a telephone number to the Select a number to dial list.

5. Set any Advanced modem features as required.

See “Setting Advanced Modem Features” on page 13 for more informat
on setting advanced modem features.

6. Click OK to close the Remote Connection dialog box. The Terminal 
window opens displaying the connection $PASH set and query comman
while Commander dials and attempts to connect to the receiver.

7. Commander connects to the receiver, and a dialog box opens indicating
connection is complete. Click OK. 

8. The dialog box and Terminal window close.

Entering a New Phone Number

Use the Dial Entry Settings dialog box (Figure 2.6) to enter or edit a dial string 
(dialing number) with descriptive comments and select full-duplex (simultaneous
send and receive) or half-duplex (send only) operation for the modem.   

Edit button Use this button to edit dialing numbers and comments.

Delete button Use this button to delete a highlighted dialing number and/or a comment in 
the list of dialing numbers.

Advanced button Use this button to open the Advanced Modem Settings dialog box.

 Table 2.3: Components of the Select Phone Number Tab

Component Description
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1. From the Select Phone Number tab in the Remote Connection dialog box, 
click the Add button to open the Dial Entry Settings dialog box (Figure 
2.6). 

2. Enter a phrase to remember the receiver number in the Comments field such 
as Rover 1 or Park1Base.

3. Enter the number for the receiver in the Dial String field. 

4. Select Duplex type as applicable to your modem. 

5. Switch to the Settings tab (Figure 2.7).

6. The default settings in the Settings tab are set to work for most modems, but 
if you have reason to use different values, select the appropriate settings, 
then click OK to save the settings close the Dial Entry Settings dialog box. 

 Figure 2.6: Dial Entry Settings Dialog Box - Dial Entry Tab

 Figure 2.7: Settings Dialog Box - Settings Tab
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7. The Select a number to dial listbox contains the number you entered. After 
selecting a number, Commander sends the number to the modem. 

Setting Advanced Modem Features

Use the Advanced Modem Settings dialog box (Figure 2.8) to view or change the 
less common modem settings. The default setting are designed to work with most 
modems. However, you can use this dialogbox to fine-tune modem settings to fit any 
particular or unique requirements of your application. The Advanced Modem 
Settings dialog box has three tabs: 

Modem Tab, Figure 2.8 and Table 2.4 

Work Mode Tab, Figure 2.9 and Table 2.5 

Modem Mode Tab, Figure 2.10 and Table 2.6 

• You can switch between tabs by clicking a different tab name.
• The OK button accepts all changes to every tab and closes the Advanced 

Modem Settings dialog box.
• The Apply button accepts changes made to the active tab, but does not c

the Options dialog box. 
• The Cancel button closes the Advanced Modem Settings dialog box, 

disregarding any changes. If Cancel is clicked after clicking Apply, the 
changes made before clicking Apply are not affected.                          

 Figure 2.8: Advanced Modem Settings Dialog Box - Modem Tab
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 Table 2.4: Advanced Modem Settings - Modem Tab 

Parameter Description

Initialization string Command which  initializes the modem. Structure depends on the particular 
modem. 

Dialing prefix Set the prefix that may be required before the actual number is dialed.

Dialing suffix Set the suffix that may be required after the actual number is dialed.

Hang up command Abort the access to the telephone line. 

Delay character Define a delay character. This character, when inserted into a string, 
introduces a delay defined by the delay time parameter. 

Delay time The time that the modem waits for a delay character (seconds).

Max time for connect Maximum time (seconds) that the modem waits for a connection. 

Turnaround time Delay from receiving message to transmitting response (seconds).

Pause between redials Waiting time between redials (seconds).

Max number of redials Maximum number of redials

DTR low to hang Option to set DTR line low when modem hangs up. 

 Figure 2.9: Advanced Modem Settings Dialog Box - Work Mode Tab

 Table 2.5: Advanced Modem Settings Dialog Box - Work Mode Tab

Parameter Description

Not to wait Click this radio button to not wait for a response from the modem. 

Waiting for the timeout Click this radio button to set the modem to wait for timeout. Inactive if 
Not to wait is active.
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Waiting for the response Click this radio button to set the modem to wait for response. Inactive if 
Not to wait is active.

Internal timeout, (ms) Internal timeout interval.

Phone list file The name the file which contains the numbers. 

Browse... Standard Windows file navigation to find and select a phone list file. 

Timeout, (ms) The time the modem waits for a response. 

Response OK indicates response has been received. 

 Figure 2.10: Advanced Modem Settings Dialog Box - Modem Mode Tab

 Table 2.6: Advanced Modem Settings Dialog Box - Modem Mode Tab

Parameter Description

Echo Check this box to display the communication traffic between 
the modem and receiver on the computer screen. 

Reply Mode Check this box to set the modem to reply by string or bytes.

Reply Check this box to turn on reply mode.

Speaker Set the internal PC speaker to On During Dial, Always On, On 
Before Answer

Dial mode Select pulse or tone mode of dialing.

Loud Set speaker volume. Range is Min, Mid, Max. Active only if 
the Reply box is checked.

 Table 2.5: Advanced Modem Settings Dialog Box - Work Mode Tab (continued)

Parameter Description
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Using the Options Dialog Box

The Options dialog box sets the following Commander parameters: Log File, Send, 
Checksums, and displaying the StartUp menu.

To open the Options dialog box, select Options from the Settings menu. The 
Options dialog box has four tabs: Log File, Send, Check, and Misc (Figure 2.11). 

• You can switch between tabs by clicking a different tab name.
• The OK button accepts all changes to every tab and closes the Options 

dialog box.
• The Apply button accepts changes made to the active tab, but does not c

the Options dialog box. 
• The Cancel button closes the Options dialog box, disregarding any changes

If Cancel is clicked after clicking Apply, the changes made before clicking
Apply are not affected.

Log File Tab

The Log File tab (Figure 2.11) is used to set the log file parameters. Table 2.7 def
the options in the Log File tab.

 Figure 2.11: Options Dialog Box - Log File Tab

 Table 2.7: Log File Tab Options

Option Description

Log to Default File Uncheck this box to write to the log file of your choice and not 
the default. Commander prompts for a file name after 
initiating the Log command.

Auto Flush Enter time interval that the log information is saved to disk. 
Default is 5 minutes.

Write Mode
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By default, the Log File tab parameters are set to not log to the default file, log to a 
new file each time, and to include all commands and response messages in the 
response file.

Send Tab

Use the Send tab (Figure 2.12) to set if you want Commander to wait for a response 
message before sending another command to the receiver. The parameters set in this 

Create New File Check this radio button to write receiver output to a new file.

Append to File Check this radio button to write receiver output to the end of 
the open file.

Overwrite File Check this radio button to write receiver output into the open 
file removing the previous contents.

Details

Commands Check this box to write the sent commands to the log file.

NMEA Output Check this box to write the NMEA output messages to the log 
file.

Raw Output Check this box to write the Raw data output messages to the 
log file.

Responses Check this box to write the command response messages to 
the log file.

Invalid Messages Check this box to write the invalid command response 
messages to the log file.

Comments Check this box to write the comment messages to the log file.

 Table 2.7: Log File Tab Options (continued)

Option Description
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tab apply to only commands sent from the Survey Application windows, and is 
useful for monitoring progress when sending many commands at once. 

The Send tab has three options, outlined in Table 2.8, along with suggested uses. By 
default, Commander sets a wait time interval of 0.5 seconds to repeat once if a 
response message is not received within the wait interval.  

 Figure 2.12: Options Dialog Box Send Tab

 Table 2.8: Options Dialog Box Send Tab Options

Option Effect Suggested Uses

Wait for command 
acknowledgment

Set the wait interval and number of 
times you wish to send the command 
again if Commander does not receive 
a response message in the wait 
interval.

Use this option when you wish to review the 
response messages for each command sent to 
verify that the command was successfully 
sent as desired. This option, however, 
requires the longest wait time when sending 
multiple commands at once.

Set wait time interval Sets a wait interval and if 
Commander does not receive a 
response message before the wait 
interval has ended, Commander does 
not resend the command.

Use this option when you wish to review the 
response messages for each command sent to 
verify that the command was sent. If a 
response message is not sent before the wait 
interval concludes, the terminal window or 
Log file do not contain the command’s 
response message verifying the command
was  sent successfully. 

No wait Sets Commander to not wait for a 
response before sending the next 
command.

Use this option if you wish to send multiple
command quickly and you do not wish to 
view the response messages to confirm th
command was sent successfully. 
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Check Tab

Use the Check tab (Figure 2.13) if you wish to view and verify the checksum 
messages on sent commands, received response messages, and parameters of 
response messages in the Terminal window. Commander automatically adds 
checksums to sent commands. This is a display feature in the Terminal window only. 
These options are useful for troubleshooting commands and responses functioning 
improperly. 

The Check tab has three options outlined in Table 2.9. By default, Commander 
verifies the checksums and parameters on received messages

 Figure 2.13: Options Dialog Box Check Tab

 Table 2.9: Options Dialog Box Check Tab

Option Description

Append Checksum on 
commands sent to receiver

Adds a checksum to the end of all commands. 

Verify checksum on 
message received

Checks the checksum in the response message. If the checksum is 
invalid, the response message turns red in the Terminal window panes.

Verify parameters on 
message received

Check the response message parameters against set permissible ranges. 
If the response parameters fall outside of the ranges, the response 
message turns red in the Terminal window panes.
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Misc Tab

The Misc tab (Figure 2.14) is used to set the StartUp dialog box display. 

A check in the Display StartUp dialog box on startup indicates that the StartUp 
dialog box opens when Commander starts.

No check in the Display StartUp dialog box on startup indicates that Commander 
uses the Connection options set in the StartUp dialog box when starting and does not 
open the StartUp dialog box.

Disconnecting From a Receiver

Commander automatically disconnects from the receiver when closed however, you 
can disconnect from a receiver without terminating Commander. To disconnect from 
a receiver without terminating Commander:

1. Select Disconnect from the Connect menu.

2. Commander disconnects from the receiver.

Getting Around in Commander

Once Commander is connected to the receiver, you can use it to send command 
parameters to the receiver, or to load the receiver parameters into Commander for 

 Figure 2.14: Options Dialog Box Misc. Tab
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viewing and editing. Figure 2.15 presents an overview of the commands menu 
structure.      

You can send commands to a receiver using either of two methods: 

• Use the Commands menu to select commands or edit the parameters. Th
sequence of commands sent from the Commands menu is called a script. A 
script can be saved to a file for later use. 

• Select Terminal from the Commands menu, and then use the Terminal 
window to send commands directly to the receiver and view the respons
messages. 

The Load function loads the receiver parameters into Commander.

The Log function writes all receiver communications and response messages to a
You can customize which types of communications and response messages to s
using the Log File tab of the Options dialog box.

You can also select the delay between sending commands and the verification o
checksums in the Options dialog box. These features are useful for verifying the 
successful sending of commands, and for troubleshooting commands and respo
that are functioning improperly.

The Status Bar at the bottom of the window describes selected menu items and 
provides information on ranges to enter when the cursor is placed in a range fiel
any descriptive parameter tab window. To hide the status bar, select Status Bar from 
the View menu to uncheck Status Bar.

 Figure 2.15: Commands Menu Structure 

COMMANDS

Post-Processing
Survey

Real-Time
Survey

All Upload Terminal

Static
Kinematic Base
Kinematic Rover

Code Differential Base
Code Differential Rover
Point Positioning

Functional 
Group
Alphabetical

Firmware
Options
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Setting Up a Receiver

Commander has tab windows, called Static Application windows (Figure 2.16) 
listing descriptions of the receiver commands, making it unnecessary for you to type 
cryptic serial port commands.     

Table 2.10 outlines the different elements numbered in Figure 2.16.

 Figure 2.16: Typical Survey Application Window

 Table 2.10: Elements of a Survey Application Window

Element Number Description

1 Survey application name.

2 Functional group or tab name.  Click on the name to switch  
the tab.

3 Description of functional group.

4 Command check boxes.  Check the box to send the command. 

5 Description of command.

6 Parameter range field. Enter a range. Status bar lists the 
permissible ranges when the cursor is placed in a range field.

7 Parameter range drop-down list box.  Click in field or on 
arrow, and select a value from the list presented.  Status bar 
lists all values when you click in the field. 

1

2
3

4 5 6
7
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Each window contains a number of functional tabs with different commands. You can 
switch between tabs by single-clicking a different tab name. 

Following is the basic procedure for setting a receiver up for a survey. 

1. Select the survey application type, All, or Setup from the Commands menu.

2. Set the commands as needed for each functional tab.

3. Send the commands.

4. Save the script, if desired for later use.

To set receiver parameters:

1. Select the survey application from the Commands menu. 

For example, if you are planning a Code Differential survey, select Code 
Differential-Rover from the Real Time Survey submenu in the 
Commands menu to set the parameters for the rover receivers in the survey.

See “Survey Applications” on page 26 for more information on 
Commander’s survey applications.

2. A Survey Application window opens corresponding to the survey option 
you choose with the Recording tab active (Figure 2.17).

3. Select parameters to set by checking the box to the left of the paramete

See your receiver manual for more information about the receiver parameters and commands.

 Figure 2.17: Recording Tab
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4. Place the cursor in the range field and type in or select the appropriate range.

The Status Bar displays the parameter ranges when the cursor is placed in the range field for a 
parameter.

To select every parameter in each functional tab, select Select All from the Edit menu. Change the 
ranges for each parameter to correspond to your needs. 

5. Select a different functional group to set by clicking a different tab name at 
the top of the Survey Application window. 

6. Select and set the parameters.

7. Continue selecting and setting parameters in each tab until complete.

Some descriptive parameters may conflict. The last parameter sent to the receiver overrides 
previously sent parameters. 

8. After setting all needed parameters for the receiver, select Send Parameters 

from the Commands menu or press the Send button  to send the 

parameters to the receiver. 

Commander sends the receiver commands corresponding to the parameters 
you selected and sent to the receiver. Depending upon the number of 
parameters and the baud rate, this procedure may take several minutes. The 
Terminal window, Figure 2.18, displays the receiver commands and 
response messages as they are sent to the receiver.      

 Figure 2.18: Terminal Window with Command and Response Messages
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Upon completion, a dialog box appears indicating that the parameters were 
sent to the receiver, as shown in Figure 2.19.    

9. Click OK. The dialog box closes.

Saving Parameter Script Files

You can save receiver parameters to a script file which can be opened at a later date to 
configure receivers identically for a given application, or loaded to a Husky, Psion, or 
other portable computer and used with the Survey Control Software to configure 
receivers. 

This is a useful feature if you are programming several rover receivers for a survey 
and you want them configured the same, or if you use the same set of receivers for 
more than one survey application and want the receivers configured identically each 
time they return to the survey application.

Commander automatically prompts you about saving the current parameter settings 
as a script file any time you close a Survey Application window, select a different 
survey application, disconnect from a receiver, or quit Commander. 

To save receiver parameters as a script file:

1. Select and set all receiver parameters as described in “Setting Up a 
Receiver” on page 22.

2. Click the Save button  or select Save or Save As from the File menu.

The File Save As dialog box opens if the receiver parameters have not be
saved as a script, or if you selected Save As from the File menu. Enter a file 
name, select a destination, and click OK.

3. If the receiver parameters have been saved as a script, Commander saves 
any additional changes to the script file.

Opening an Existing Script File

Saved script files can be opened for editing or used to configure receivers. 

 Figure 2.19: Commander Dialog Box
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To open a script file:

1. Click the Open button  or select Open from the File menu.

The File Open dialog box opens.

2. Select the script file you wish to open, and click OK.

3. If a script file is opened and/or unsaved, a dialog asks if you wish to save the 
changes to the script. Click Yes, No, or Cancel.

Any opened Survey Application windows close, and a Survey Application 
window for the script opens with the parameters from the script file listed.

Loading Receiver Parameters From a Receiver

You can determine a receiver’s parameters by loading the parameters from the 
receiver. This option is only available when a Survey Application window is open 
and active. 

The Load function does not directly indicate the survey application the receiver w
configured for. Loaded receiver parameters display in the active Survey Application 
window, and this survey application window may not necessarily be the survey 
application the receiver was configured for. 

To load configuration parameters from a receiver:

1. Open a Survey Application window by selecting an application type, All, 
Post Process, or Real-Time Survey from the Commands menu.

2. Click the Load button  or select Load from the Commands menu.

The Status Bar displays “Loading” indicating that Commander is loading 
the receiver parameters.

The process typically takes ten to fifteen seconds. After loading the rece
parameters from the receiver, a dialog indicates the process has finishe

3. Click OK.

4. The receiver parameters listed in the Survey Application window change to 
reflect the parameters loaded from the receiver.

Survey Applications

When setting up your receiver, you first need to decide what type of survey to 
conduct. The Commands menu provides several options for setting receiver 
parameters depending on the type of survey, either post-processing or real-time
summarized in Table 2.11. 
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In a post-processing survey, you can select parameters for static, kinematic base, or 
kinematic rover. In a real-time survey, you can select code differential base, code 
differential rover, carrier phase base/rover (if your receiver has this capability), or 
point positioning.   For more information on selecting a survey type, see your receiver 
manual.

Post Process Survey and Real Time Survey are application groups and only allow you 
to select and set receiver parameters applicable to the specific survey.

ALL lists all available parameters alphabetically or by function.

Alphabetical Listing alphabetizes the $PASH commands and does not contain as 
much descriptive information as the other options.

 This manual only covers accessing the command screens and changing parameters for each 
application. For more information on receiver commands, see the receiver manual.    

 Table 2.11: Survey Types

Survey Type Survey Description Requirements

Post Processing - 
Static

Long occupation time on a single survey 
point.

Base and rover receiver data collected 
simultaneously and post-processed

Post Processing - 
Kinematic

Short occupation time of multiple 
survey points.

Maintain lock on at least four satellites 
at all times during survey. Base and 
receiver data collected simultaneously 
and post-processed.

Real Time - Code 
Differential

Receiver position is differentially 
corrected in real-time using RTCM 
corrections.

Base station is broadcasts corrections 
via radio link.

Real Time - Carrier 
Differential

Receiver position is differentially 
corrected in real-time using CPD 
corrections.

Base station is broadcasts corrections 
via radio link.

Real Time - Point 
Positioning

Long occupation time on single survey 
point.

Receiver positions are averaged to 
minimize error.
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The receiver parameters are listed by function and described in Table 2.12. 

Receiver Setup

The Receiver Setup option in the Commands menu allows you to set a receiver’s 
basic operating configuration including the baud rate for the serial port, resetting
receiver, and turning off the power (Figure 2.20).   For more information on the 
commands, see the receiver manual.        

 Table 2.12: Receiver Command Functional Groups 

Functional 
Group

Description

Recording Data recording including: elevation mask, epoch counter, recording interval, switch, and 
mode

Site Antenna site information including: antenna altitude, slant, radius, height, latitude, 
longitude, site identifier, project information.

Position Position computation including: HDOP mask, PDOP mask, position elevation mask, 
position mode, VDOP mask, enable/disable use of unhealthy satellite.

Tracking Satellite tracking including: selection of satellites to track, Z mode switch.

RTCM Code phase differential including: enabling/disabling auto-differential, RTCM type, 
setting differential parameters.

CPD Carrier phase differential including: CPD modes, CPD parameters, multipath, PNAV 
processing cycle.

NMEA Real-time data output including: enabling/disabling NMEA messages on each serial 
port.

RAW Real-time data output including: enabling/disabling RAW messages on each serial port

Sessions Session programming including: reference day, offset time, session name, session flag, 
recording interval, session elevation mask, minimum number of satellites to use. 

PPS Event marker input/1-pulse-per-second output.

Local Local receiver coordinates and time compared to UTC.

Misc Miscellaneous commands that do not fit in other functional groups including: modem 
and daisy chain commands.

Setup Receiver setup commands including: initialization, save current parameters, port baud 
rates.
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Receiver Information

The Receiver Info dialog box (Figure 2.21) lists information on the receiver type, 
firmware and channel version, channel/codeless options, and installed options. The 
options are indicated by a letter or number; see your receiver manual for information 
on options. You need this information if you have to discuss a receiver problem with 
Customer Support.

To open the Receiver Info dialog box, select Receiver Info from the View menu. 

 Figure 2.20: Typical Receiver Setup Survey Application Window 
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Click Close to close the Receiver Info dialog box. 

Using the Terminal Window

The Terminal function has two primary purposes:

• Display communications between the receiver and computer.
• Send set and query commands to the receiver.

Experienced users can use the Terminal window to send commands to the receiver.
See the receiver manual for more information on receiver commands and forma

To open the Terminal window, select Terminal from the Commands menu or click 
the Terminal button .

 Figure 2.21: Receiver Info Dialog Box
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Communicating with the Receiver

The Terminal window (Figure 2.22) can be used to send set and query commands to 
the receiver. 

1. Select the $PASHS or $PASHQ button corresponding to the command you 
wish to send (e.g. $PASHQ, for RID or $PASHS, for INI).

2. Type the rest of the receiver command and the parameters in the Command 
field.

3. Click Send or press <Enter>.

4. If you wish to pause the display to more easily view commands and receiver 
responses in the panes, click the Pause check box.

Pause also makes it possible to select responses to copy to the Windows clipboard. 

Command History

The drop down arrow  next to the Command field in the Terminal window opens 
a drop-down list box with all commands sent to the receiver in the current session. 
This includes any commands sent when connecting to the receiver.

 Figure 2.22: Terminal Window
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The commands are listed in chronological order, however the same command is only 
listed once. If a command is repeated, it moves to the top of the commands history 
list.

1. Click the drop down arrow  next to the Command field.

2. Select a command from the list presented. The scroll bar enables you to 
scroll up and down through the list.

The command appears in the Command field.

3. Edit the command or parameters, if necessary.

4. Click Send or press <Enter>.

Copying and Pasting Commands

Highlighted commands or responses in any pane or in the Command field can be 
copied to the Clipboard when the Pause check box is checked or if the receiver is 
disconnected. To copy text, highlight the text, and do one of the following:

• select Copy from the Edit menu

• click the Copy button  
• type [Ctrl]+C
• select Copy from the right mouse pop-up menu.

The contents of the Clipboard can be pasted to the Command field at any time. To 
paste text, place the cursor in the Command field and do one of the following:

• select Paste from the Edit menu

• click the Paste button  
• type [Ctrl]+V
• select Paste from the right mouse pop-up menu.

Customizing the Terminal Window

The Terminal window (Figure 2.23) has four panes which can be customized for 
your particular needs. For example, to ease viewing receiver communications, y
may wish to set one pane to display only NMEA messages, a second pane disp
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RAW data messages, and a third pane display commands, responses, and invalid 
messages.

1. Drag the pane separators (Figure 2.23) along the vertical and horizontal 
scroll bars to size the panes as needed.

2. Click the right mouse button to access the Terminal pop-up menu.

By default, all options are selected to display except Show Hexadecimal.

Table 2.13 outlines the menu options. 

 Figure 2.23: Terminal Window

 Table 2.13: Terminal Pop-Up Menu Options

Option Description

Copy Copies the selected text in the Command field to the 
Clipboard. Only available when the Pause box is checked, or 
if the receiver is disconnected.

Paste Inserts the contents of the Clipboard at the cursor in the 
Command field. Only available when connected to a receiver.

Show Commands A check mark next to this option shows the commands in the 
pane. No check mark hides the commands.

Show NMEA Data Message Output A check mark next to this option shows the NMEA data 
output messages in the pane. No check mark hides the NMEA 
data output messages.

Show RAW Data Message Output A check mark next to this option shows the RAW data output 
messages in the pane. No check mark hides the RAW data 
output messages.

Pane Separators
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3. Select an option to hide or display in the pane.

4. The Terminal pop-up menu closes.

5. Repeat steps 2 and 3 for each additional option you wish to change.

Logging Receiver Messages

The Log function allows you to save all receiver commands and response messages to 
a file. This feature is useful if you want to record NMEA or RAW messages from the 
receiver for further analysis.

The Log function saves the receiver commands and responses messages specified in the Log File Tab 
of the Options dialog box. These commands and response messages do not necessarily correspond to 
commands and response messages displayed in the panes of the Terminal window. Commands and 
response messages displayed in the Terminal window panes are set independently from the Log file.

To log a file:

1. Select Log from the File menu or click the Log button .

2. If you unchecked the Log to Default File box in the Options dialog box, the 
Log to File dialog box opens. Select or enter a file name, select a 
destination, and click OK.

Commander writes all receiver communications corresponding to the 
Details options selected in the Options dialog box.

Show Responses A check mark next to this option shows the ACK and NAK 
response messages in the pane. No check mark hides the 
response messages.

Show Invalid Messages A check mark next to this option shows the invalid response 
messages in the pane. No check mark hides the invalid 
response messages. An incomplete message or bad checksum 
is considered “invalid.”

Show Comments A check mark next to this option shows the comments in the 
pane. No check mark hides the comments.

Hexadecimal Display A check mark next to this option shows the response messag
in hexadecimal format in the pane. No check mark shows the  
response messages in ASCII format.

 Table 2.13: Terminal Pop-Up Menu Options (continued)

Option Description
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To stop logging receiver communications, select Log from the File menu so it is 
unchecked, or click the Log button.

Menus and Toolbar

The menu bar lists the menus to access the various functions. Commander has seven 
menus to access the function. Table 2.14 outlines the menus and the associated 
function.

 Table 2.14: Commander Menu System

Menu Item Description Shortcut

FILE

Open Opens a script file.

 

Close Closes the current script file.  

Save Saves the current script file. See “Saving Parameter Script Files” on 
page 25 for more information.  

Save As Saves the current script file to a name specified in the Save As dialog 
box. See “Saving Parameter Script Files” on page 25 for more 
information.

 

Log Logs the communication messages to a file. Specify the log file name in 
the Options dialog box. See “Logging Receiver Messages” on page 34 
for more information.

 

1...
2...
3...

List of the most recently opened script files. Selecting one opens the 
corresponding script file.

 

Exit Quits Commander.  

EDIT

Copy Copies the highlighted text to the Windows clipboard. Only available in 
the Terminal window.

[Ctrl]+C

Paste Inserts the contents of the Windows clipboard at the cursor. Only 
available in the Terminal window.

[Ctrl]+V

Select All Check every command listed in each tab of the Survey Application 
window. Adjust ranges as necessary for each command.
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Unselect All Unchecks every command listed in each tab of the Survey Application 
window.

SETTINGS

Direct Connect
Remote Connect
Disconnect

Opens the Communications dialog box to connect to a receiver. See 
“Starting Commander” on page 5 for more information.  

Options Opens the Options dialog box to set Log File, Send, Check, and 
Miscellaneous information. See “Using the Options Dialog Box” on 
page 16 for more information.

 

COMMANDS

Post Processing 
Survey

Opens descriptive parameters window to set receiver parameters for 
Static, Kinematic Base, or Kinematic Rover surveys. See “Setting Up a 
Receiver” on page 22 and “Survey Applications” on page 26 for more 
information.

Real Time Survey Opens descriptive parameters window to set receiver parameters for a 
Code Differential Base, Code Differential Rover, Carrier Differential 
Base, Carrier Differential Rover, or Point Positioning survey. See 
“Setting Up a Receiver” on page 22 and “Survey Applications” on 
page 26 for more information.

All Opens Survey Application window for all parameters by Functional 
Group or Alphabetical Listing. See “Survey Applications” on page 26 for 
more information.

Setup Opens Receiver Setup parameters window. See“Receiver Setup” on 
page 28 for more information.

Upload Provides capability to load updated firmware and options to receiver.

Send parameters Uploads and sets the parameters in the current descriptive parameters 
window to the receiver. See“Setting Up a Receiver” on page 22 for more 
information.

[Ctrl]+S

Load parameters Downloads the receiver parameters to the open descriptive parameters 
window. See “Loading Receiver Parameters From a Receiver” on 
page 26 for more information.

[Ctrl]+L

Show Advanced Active after a survey type is selected under Post Process or Real Time.   
Click to turn on or off. If off, only the basic script settings are displayed. 
If on, all script settings are displayed. 

Terminal Opens the Terminal window to manually send receiver commands and 
queries to the receiver. See“Using the Terminal Window” on page 30 for 
more information. 

 

 Table 2.14: Commander Menu System (continued)

Menu Item Description Shortcut
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The Commander Toolbar provides easy access to frequently used commands.

• To display the Toolbar, select Tool Bar in the View menu.

VIEW

Receiver Info Opens the Receiver Info dialog box listing information describing the 
receiver and installed options. See “Receiver Information” on page 29 
for more information.

 

Toolbar A check mark next to this menu item indicates the Toolbar is visible. No 
check mark indicates the Tool Bar is hidden.

Status Bar A check mark next to this menu item indicates the Status Bar is visible. 
No check mark indicates the Status Bar is hidden.

WINDOW

Cascade Arrange all open windows so they overlap.

Tile Horizontally Arrange all open windows as non-overlapping tiles in a horizontal row. 

Tile Vertically Arrange all open windows as non-overlapping tiles in a vertical row. 

Arrange Icons Arranges icons (minimized windows) at the bottom of the window.

1...
2...

List of open and minimized windows. Selecting one activates and moves 
the window to the top.

HELP

Search for Help 
On...

Displays a comprehensive index to information contained in the Help 
system.

 

Contents Opens the on-line Help system. [F1] or

Tech Support Displays information on contacting customer support.

About 
Commander...

Displays information about Commander.

 Table 2.14: Commander Menu System (continued)

Menu Item Description Shortcut
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• To choose a command from the Toolbar, click the button. 

 Table 2.15: Commander Toolbar Buttons

Button Description

Open Button - Click this button to open an existing setup file. See “Opening an 
Existing Script File” on page 25 for more information.

Save Button - Click this button to save the current setup parameters to a setup 
file. See “Saving Parameter Script Files” on page 25 for more information.

Copy Button - Click this button to copy the selected command to the Clipboard.
See “Copying and Pasting Commands” on page 32 for more information.

Paste Button - Click this button to paste the contents of the Clipboard at the 
insertion point. See “Copying and Pasting Commands” on page 32 for more 
information.

Communications Button - Click this button to connect to a receiver. See 
“Connecting to a Receiver From the Main Window” on page 7 for more 
information.

Terminal Button - Click this button to open the Terminal window to send and 
receive commands to a receiver. See “Using the Terminal Window” on page 30
for more information.

Log Button - Click this button to log the receiver commands and response 
messages to a file. See “Logging Receiver Messages” on page 34 for more 
information.

Send Button - Click this button to upload the receiver parameters to the receiver.
See “Setting Up a Receiver” on page 22 for more information.

Load Button - Click this button to download the receiver parameters to the open
descriptive parameters window. See “Loading Receiver Parameters From a 
Receiver” on page 26 for more information.

Help Button - Click this button to open the on-line help system. 
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Overview

The Upload utility, within Commander, is used to load updated firmware and new options 
into your receiver. Table 3.1 lists the file names of the various firmware/options. Firmware 
updates can be obtained from Customer Support via disk, e-mail, or other means; options 
must be purchased.       

1. Copy the firmware/option file(s) into a directory of choice in your computer.  

2. Make sure your receiver is connected to the PC and is operating, as specified in 
the Chapter 3, Commander.

3. Start Commander. 

4. Select Upload from the Commands menu.   

 Table 3.1: Firmware and Options Identification

Receiver Firmware Filename Options Filename

SCA-12 GTAB.BIN
MTAB.BIN
INT.BIN

Assigned at time of purchase.

GG-24 24C_????.DAT
where ???? is the firmware version, 
e.g. “GF00”

Z-12 BIN.DAT
BIN_L.DAT
NAV.DAT

Z-Surveyor MZCODE.BIN
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5. Click on Upload, then click on Firmware or Options, as applicable.  The 
Select dialog box opens, similar to Figure 3.2.       

6. Navigate to and select the firmware/option file(s).

7. Click OK. 

Upload loads the firmware/option to your receiver.       

 Figure 3.2: Typical File Selection Dialog Box

CAUTION

1. Make sure the firmware/option file is correct for your receiver. An improper 
file can corrupt the receiver, making the receiver unusable and requiring return 
to factory.
2. Make sure there is no possibility of power interruptions when using Upload. 
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This chapter describes the tasks necessary to download data from a receiver to a PC. The 
download procedure depends upon the storage arrangement used in the receiver. In most 
receivers, the data are stored in the receiver memory; some receivers store data on a 
PCMCIA card. 

Starting Download

Start Download by double-clicking the Download icon in the RCS  program group. The 
Download main window opens (Figure 4.1).    

Transferring Data - Overview

You can transfer data directly from the receiver, or from a PCMCIA card removed from 
the receiver. 

Transferring a data set from the receiver to a PC requires two steps: 

1. Connect PC to receiver. 

2. Download the data set.

 Figure 4.1: Download Main Window
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Transferring a data set from a PCMCIA card requires three steps:

1. Remove PCMCIA card from receiver and insert card in the PCMCIA drive 
in your PC.

2. Select PC drive corresponding to PCMCIA card.

3. Download the data set. 

Transferring Data Directly from the Receiver

1. Click the Connect button .

If you select Auto Connect from the Data Source menu of the Connect 
menu, RCS queries the receiver serial port, and connects to the receiver 
using the communications parameters that it finds on the port. 

If the receiver outputs NMEA or RAW data messages from the serial port, Download can not connect 
to the receiver. Switch to a different receiver port or turn off all automatic messages. Commander 
connects over automatic messages, and the messages are easily turned off. Refer to your receiver 
manual for more information.

The receiver stops recording data on the receiver memory card and closes the active file when 
Download connects to the receiver.

2. After successfully connecting to the receiver, the Receiver pane lists the files 
in the receiver. 

3. Before copying or moving, verify that destination directory is active in the 
PC pane. 

4. If you need to create a directory, click on the New directory button .

A field for the new directory appears in the PC pane. Enter a directory name. 

5. If you wish to set or change the session information stored with the data, 
select Session on Downloading from the Edit menu. 

If you are using the Z-12, SCA-12, or GG-24 receiver, after copying or 
moving the files the Session Information dialog box opens, and you can 
change any information as needed. 

If you are using the Z-Surveyor receiver, the Session Information dialog box 
opens before the files are copied or moved.

6. Select the file(s) that you want to copy or move in the Receiver pane. You 
can select one, several, or all the files to transfer. 

To select particular files, use the Control key. To select a group of 
contiguous files, use the Shift key.     
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7. To copy files from the receiver, click the Copy button . This does not 
delete the files from the receiver memory.

8. To move the files to the PC and delete them from the receiver memory, click 

the Move button .

Transferring Data from PCMCIA Card in a Local Drive

1. Remove the PCMCIA card from the receiver and place it in the PCMCIA 
drive of your computer.

2. Select PC Drive from the Data Source menu in the File menu.      

3. The drive selection menu becomes active in the Receiver pane.    

4. Select the PCMCIA drive. 

5. The Receiver pane lists all data files stored on the PCMCIA card. 

6. Before copying or moving, verify that destination directory is active in the 
PC pane. 

7. If you need to create a directory, click on the New directory button .

A field for the new directory appears in the PC pane. Enter a directory name. 

8. Select the file(s) that you want to copy or move in the Receiver pane. You 
can select one, several, or all the files to transfer. 

To select particular files, use the Control key. To select a group of 
contiguous files, use the Shift key.     

9. To copy files from the PCMCIA card, click the Copy button . This does 
not delete the files from the PCMCIA card.

10. To move the files to the PC and delete them from the PCMCIA card, click 

the Move button .
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Handheld Transfer provides communication between a PC and a handheld controller, to 
quickly copy, move, and delete files between the handheld and PC.   Handheld Transfer 
supports the Husky FS/2 or FS/3 and the Psion WorkAbout handheld controllers. 

Before Using Handheld Transfer

Before connecting the handheld to the PC, the handheld must be set to communicate with 
the PC. If you are using a FS/2 or FS/3, go to “FS/2 or FS/3 Setup” on page 45; if you are
using a Workabout, go to “Workabout Setup” on page 46.

FS/2 or FS/3 Setup

1. Connect the FS/2 or FS/3 serial port 1 to a COM port on your PC using the s
data cable. 

2. Power on the FS/2 or FS/3 by pressing the red power key W.

3. If the FS/2 or FS/3 displays a DOS prompt C:\> prompt go to step 6.   

To reboot the FS/2 or FS/3, simultaneously pressing SHIFT+SHIFT+POWER (both shift keys and red 
power key) and holding for about 2 seconds. 

4. If the FS/2 or FS/3 has been recharged, or if a power interruption has occur
(e.g., the batteries were replaced), then the FS/2 or FS/3 power parameters 
may appear, similar to Figure 5.1. If this is the case, change the settings as 
necessary (continue or stop recharging), and press ESC until you get a DOS 
prompt, and continue with step 6.  

See the FS/2 or FS/3 User’s Guide for more information on recharging batteries. 

 Figure 5.1: FS/2 or FS/3 Power Parameters Screen
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5. If the FS/2 or FS/3 was running a program when last powered off, the 
program resumes when the FS/2 or FS/3 is turned back on. If this is the case, 
exit the program and go to step 6. 

6. The FS/2 or FS/3 should display the DOS prompt C:\>. Type HCOM and 
press the Yes hey to start the File Transfer Utility. 

The File Transfer Utility screen appears indicating that the file transfer 
program is running, and ready to communicate with the PC. 

7. To transfer files, go to “Using Handheld Transfer” on page 46.    

8. Press the Esc key on the FS/2 or FS/3 to exit the file transfer utility and 
return to the DOS prompt. 

Workabout Setup

1. Connect the Workabout serial port A to a COM port on your PC using th
serial data cable. 

2. Turn on the Workabout by pressing the On/Esc key.

3. Exit any application so that the M. prompt displays.

4. Press the Menu key. 

5. Use the arrow keys to access the Special menu

6. Select Remote Link and press the Enter key to access the Remote Link 
screen appears. 

7. Use the left or right arrow key to toggle Remote Link to ON 

8. Use the down arrow key to move to the baud rate and select the baud r
with the left or right arrow keys. Baud rates up to 19200 are supported. 

As soon as Remote link is ON, the parameters are sent to the PC, and 
continue until the Workabout is turned off.   

The Remote Link screen also allows you to select the port. Always select port A.   

You are now ready to communicate with the Workabout.

9. Press the On/Esc key to exit the Remote Link screen.

Using Handheld Transfer

After preparing the handheld to communicate with the PC, you can use Handhe
Transfer. 
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1. Double-click the Handheld Transfer icon on the PC. The Handheld 
Transfer main window opens (Figure 5.2).       

The left half of the display is the Handheld pane, which shows the files in the 
handheld. The right half of the display is the PC pane, which shows the files, if any, in 
the indicated directory of the PC. The blue bar along the top edge of the pane shows 
that the pane is active (in the illustration above, the blue bar indicates the Handheld  
pane is active).

You use these two panes to transfer files from datalogger (handheld) to PC, or from 
PC to datalogger. The files may be data collected from a GPS receiver, executable 
files, templates such as FDF (feature definition) files, or any kind of information that 
must be transferred between units. 

Operation

Switching Between Panes 

To switch between panes, use one of the following methods: 

1. Click the pane you want to be the current pane. 

2. Use the Tab key on your keyboard.

3. Click the Change pane button on the toolbar.

 Figure 5.2: Handheld Transfer Main Window
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Connecting a Handheld

Handheld Transfer provides two methods to connect a handheld: Connect and Auto 
Connect. 

Connect Method

1. Click on Handheld.  The Handheld menu appears, as shown in Figure 5.3.    

2. Choose Connect from the Handheld menu or click the Connect button.  
The  Connect to Handheld dialog box opens, as shown in Figure 5.3.     

3. In the Select available PC’s box, click the down arrow and select the PC 
COM port that you want to use.

4. In the Set baud rate box, click the down arrow and select a baud rate from 
the list box.

5. Press OK .  The Handheld Transfer software now connects your handheld to 
the PC using the parameters that you selected. 

Auto Connect Method  

1. Switch to the Handheld pane on the PC display.

2. Choose Auto connect from the Handheld menu.    

Once the handheld is connected, Disconnect becomes available in the Handheld menu.

Viewing a List of Files and Directories

You can change the appearance of files and directories using the Brief  or Full  bottons 
on the Toolbar.

•   Brief displays files and directories as a list

 Figure 5.3: Connect to Handheld Dialog Box
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•   Full displays files and directories with information about size and day of last 
modified.

Selecting a Drive

Handheld Transfer displays files and directories on the active drives of your 
computer or handheld. To change the active drive:

1. Click on the arrow to the right of the Drive drop down listbox.    

2. Select the drive.  

The pane lists all files and directories on the drive.   

3. Navigate to a directory on the drive as needed.

The title bar lists the active drive and directory.

Copying and Moving Files

You can use Handheld Transfer to transfer a single file or multiple files. 

To copy a  file do  the following:                                               

1. Make sure the destination directory is active. 

2. Select the file or multiple files you want to copy. To select more than one
file, hold down the Control key while selecting files.

3. Select Copy to from the File menu or press the Copy to button .

You can copy files by using the right-click menu, or by clicking and dragging the files from one pane 
to the other. 

To move a file or multiple files from the handheld current directory  to the PC curr
directory, or vice versa:

1. Make sure the destination directory is active.

2. Select the file or multiple files you want to move. To select more than on
file, hold down the Control key while selecting files.

3. Select Move to from the File menu or press the Move to button .

4. Moving files deletes them from

You can copy files by using the right-click menu, or by clicking and dragging the files from one pane 
to the other.
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To configure your radio, Pacific Crest or Ashtech, select the Utilities icon in the Receiver 
Communications program group to open the Utilities window (Figure 6.1).   

The Utilities window has three selections to configuring your radio:

SS-Radio Programming - Use to program SSRadio firmware. Refer to the SSRadio 
User’s Guide for more information.

SS-Radio Setup - Use to configure SSRadio operating parameters Refer to the 
SSRadio User’s Guide for more information.

UHF-VHF Radio Setup - Use to configure Pacific Crest radio.

Pacific Crest UHF/VHF Radio Setup 

Use the Pacific Crest UHF/VHF Radio Setup application to view and change the 
settings on Pacific Crest UHF/VHF radios. With this application you can set the frequ

 Figure 6.1: Utilities Window
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channel, sensitivity, and data link speed (radio to radio) for a receiver with an internal 
radio, a receiver with an external radio, or a direct pc to radio connection.

Double-click UHF-VHF Radio Setup in the Utilities window to start Pacific Crest 
UHF/VHF Radio Setup to the main window opens (Figure 6.2) 

The parameters are available to change after connecting to a radio.

Connecting to a Pacific Crest Radio

1. Connect the radio to the PC using the serial data cable. See the radio manual 
for more information.

2. Click the arrow to the right of the Receiver <-> Radio Port field, and select 
how the radio is connected to the receiver. 

-or-

If the radio is directly connected to the PC without a receiver, check the 
Radio Direct check box. 

3. Click the arrow to the right of the Computer COM Port field, and select the 
COM port on the pc the radio is attached.

4. Click Connect to connect to the radio. 

Depending on the make and model of your radio, it may be necessary to 
cycle the radio power before connecting. If this is the case, a dialog box 
opens asking you to do this. Click OK, and cycle power to the radio within 
10 seconds.

 Figure 6.2: UHF-VHF Radio Setup Main Window
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5. Upon successfully connecting to the radio, the main window displays the 
current settings for the radio (Figure 6.3). 

6. Make any necessary changes to the Frequency Channel, Sensitivity and Data 
Link Speed. The available choices reflect the specifications of the radio.

7. Click Program to save the changes in the radio.

8. Click the Close box to quit the application and break the communication 
link. 

 Figure 6.3: UHF-VHF Radio Setup Main Window - Connected
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RINEX Converter
RINEX Co

erter

ames 
RINEX (Receiver INdependent EXchange) is a standard format for GPS, GLONASS, or 
GPS+GLONASS data supported throughout the industry.

RINEX Converter provides a means to translate single or multiple RINEX formatted data 
files from any receiver to Ashtech formatted files, and, alternatively, convert Ashtech data 
files to RINEX format. RINEX Converter supports RINEX format version 2.01.

When RINEX Converter converts a RINEX file to Ashtech format, the conversion can 
produce up to four types of data:

Obs Observation data

Nav Navigation data

Nav G GLONASS navigation data if available 

Met Meteorological data if available

In addition, the observation data is separated into three files:

B-file GPS measurement data

E-file Satellite ephemeris data

S-file Site information, if recorded in receiver at time of observation

Preliminary Operations

Before you perform any conversions, create four directories to avoid confusion.

• Rinexin - Create this directory and load your RINEX files into it.
• Rinexout - Create this directory. Later, you will put your converted RINEX-

Ashtech files in this directory.
• Ashin - Create this directory and load your Ashtech files into it.
• Ashout - Create this directory. Later, you will put your converted Ashtech-

RINEX files in this directory.

The directory names listed above are suggestions; you can use whatever directory n
you prefer. 
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Starting RINEX Converter

1. Select the RINEX Converter in the Utilities window to open the RINEX 
Converter to the RINEX to Ashtech tab opens (Figure 7.1).         

Use the RINEX-to-Ashtech tab to select the files you want to convert to 
Ashtech format, and define the conversion options. Table 7.2: describes the 
fields in the RINEX to Ashtech tab.      

 Figure 7.1: RINEX-to-Ashtech Tab

 Table 7.2: RINEX to Ashtech Tab Parameters 

Item Description

File types Lists the file types: RINEX Observation files (*.*O), All files (*.*). RINEX NAV-
files*.*N, RINEX Nav g-files*.*G, RINEX Met-files *.*M. To select a file type, click 
the arrow to the right of the field and select file type from the list presented.

Available files 
list

Lists the files in the current directory. To select a file, click on the file. To select 
multiple files, select the first file, hold down the Ctrl key, and select additional files.

Obs Lists the file name of the observation data file corresponding to the selected RINEX 
data file in the available files list.

Nav Lists the file name of the GPS navigation data file corresponding to the selected 
RINEX data file in the available files list.

Navg Lists the file name of the GLONASS navigation data file corresponding to the 
selected RINEX data file in the available files list. The field is empty if GLONASS 
data were not collected.

Met Lists the file name of the Meteorological data file corresponding to the selected 
RINEX data file in the available files list. The field is empty if meteorological data 
were not collected.
Receiver Communications Software User’s Guide



RINEX Co

R
IN

E
X

 C
onverter
BEGIN Click this button to begin converting the RINEX files to Ashtech format. 

B-File Lists the suggested file name for the output B-file (raw measurement data).

E-File Lists the suggested file name for the output E-file (ephemeris data).

S-File Lists the suggested file name for the output S-file.(site information). The field is 
empty if site data were not entered into receiver. 

Input dir Click this button to open the Set input directory dialog box. 

Set input 
directory 

Lists the directory where the RINEX files are stored. 

= Click this button to set the output directory the same as the input directory.

Output dir Click this button to open the Set output directory dialog box. 

Set output 
directory

Lists the directory where converted data files will be stored. 

Overwrite files Select the overwrite options: Prompt for Overwrite, Always overwrite, or Never 
overwrite. To select an overwrite option, click the arrow to the right of the field and 
select an overwrite option from the list presented.

GPS Check this box if the source data files contain GPS data. This option is set default.

GLONASS Check this box if the source data files contain GLONASS data. This option is on by 
default. Do not check unless a GLONASS receiver was used to collect data.

B-File Check this box to create a B-file (position data) when converting RINEX files.

E-File Check this box to create a E-file (ephemeris data) when converting RINEX files.

S-File Check this box to create a S-file (site information) when converting RINEX files. The 
S-file is created only if site data are included in the RINEX file.

Free Space Displays the available drive space for the selected output directory.

Exit Closes RINEX Converter.

About Opens the About dialog box which displays the software version number.

Help Opens the on-line help system.

 Table 7.2: RINEX to Ashtech Tab Parameters  (continued)

Item Description
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Converting RINEX to Ashtech Format

RINEX files from any GPS receiver can easily be converted to Ashtech format for 
post-processing. Verify that the RINEX files are saved to your hard drive before 
converting them. 

If you are converting RINEX files translated from a RINEX converter that does not use the standard 
RINEX naming format, the observation files may not have the format *.*O. If the files are not listed 
in the Available Files list, change the File Types to All Files on the RINEX to Ashtech tab and All 
Files in the Input Directory.

1. In the RINEX to Ashtech tab, click Input dir to open the Set Input 
Directory dialog box (Figure 7.3).      

2. Using standard Windows file navigation procedures, navigate to the 
directory where the RINEX data files are located and click Save. 

The Set Input Directory dialog box closes. The Input Directory lists the 
directory path, and the Available Files list lists the RINEX files in the input 
directory (Figure 7.4). 

 Figure 7.3: Set Input Directory Dialog Box 
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Depending upon the type of file (i.e. Obs or Nav), the OBS, NAV, B-File and 
E-File fields populate with suggested file names. Nav g, Met, and S-file 
names may also appear if the information is contained in the RINEX file.  

3. Click Output dir to open the Set Output directory dialog box (Figure 7.5). 

4. Using standard Windows navigation procedure, navigate to the directory 
where you want to store the converted files, and click Save. 

To avoid confusion, save the converted Ashtech files to a directory different than where the RINEX 
files are located. 

The Set Output Directory dialog box closes. The Output Directory lists 
the directory path.

 Figure 7.4: RINEX-to-Ashtech Tab with Suggested Output File Names

 Figure 7.5: Set Output Directory Dialog Box 
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To avoid confusion, do not change the suggested file names. To restore the original suggested output 
file name, double-click the filename in the available files list.

5. Select the Overwrite files option by clicking the arrow to the right of the 
Overwrite files list, and selecting an option from the list presented. There 
are three overwrite options:

• Prompt for Overwrite - (Default setting). If RINEX Converter detects 
that a converted file has the same name as an existing file, meaning
new file overwrites the existing file. A dialog box opens asking if you
wish to overwrite the existing file. If you click NO, RINEX Converter 
skips the file, and continues to the next file.

• Always Overwrite - This option always writes over existing files with a
new file.

• Never Overwrite - This option does not overwrite data for a given file
if a file with the same name already exists.

By default, RINEX Converter assumes that the RINEX files use both GPS
and GLONASS (Nav g) data, however a Nav g file does not display unless a
GLONASS receiver was used to collect data.

By default, RINEX Converter creates a B-file (GPS position data), an E-Fil
(satellite ephemeris), and an S-File (site parameters, if recorded) in Ash
format. If you do not want one or more of these file types created, unche
the corresponding check boxes. Be aware that the S-file does not create
unless the site information is recorded in the receiver file. 

6. Click BEGIN to convert the selected RINEX files to Ashtech format. The
Conversion status dialog box opens (Figure 7.6). 

 Figure 7.6: Conversion Status Dialog Box 
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The Conversion status dialog box indicates the status of each file as it 
converts. Upon completion, the display indicates 100% for each file, or 0 if a 
file was not converted for lack of data, e.g. GLONASS data. 

• Click Cancel to cancel the conversion to the current file type and 
proceed to the next file type.

• Click Cancel All to cancel the entire conversion.

RINEX Converter creates a *.log file in the directory containing all 
conversion activity. After restarting, RINEX converter overwrites the 
existing log file. To save the old log file, rename or move the file before 
restarting RINEX Converter. 

The selected RINEX files are now in Ashtech format and can be used with data 
from Ashtech receivers for post-processing. 

Converting Ashtech Files to RINEX Format

RINEX Converter can convert Ashtech files from any GPS or GPS+GLONASS 
receiver into RINEX format.

1. Click the Ashtech to RINEX tab to switch to the Ashtech to RINEX tab 
(Figure 7.7).    

 Figure 7.7: Ashtech to RINEX Tab 
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Table 7.8: describes the fields in the Ashtech to RINEX tab.

 Table 7.8: Ashtech to RINEX Tab Fields 

Item Description

File Types Lists the files types: Ashtech B-Files (B*.*), Ashtech E-files 
(E*.*), Ashtech S-files (S*.*) or All files (*.*). To select a file 
type, click the arrow to the right of the field and select file type 
from the list presented.

Available files list  Lists files in current directory. To select a file, click on the file. To 
select multiple files, select the first file and then hold the Ctrl key 
while selecting additional files.

B-File Lists the file name of the B-File corresponding to the selected 
Ashtech data file in the available files list.

E-File Lists the file name of the E-File corresponding to the selected 
Ashtech data file in the available files list.

S-File Lists the file name of the S-File corresponding to the selected 
Ashtech data file in the available files list.

BEGIN Button Click this button to begin converting the Ashtech files to RINEX 
file format. 

Obs Lists the file name for the converted observation data file.

Nav Lists the file name for the converted navigation data file.

Navg Lists the file name for the converted GLONASS navigation data 
file.

Met Lists the file name for the converted meteorological data file.

Input dir Click this button to open the Set input directory dialog box.

Set input directory Displays the directory for the source files.

= Click this button to set the output directory the same as the input 
directory.

Output dir Click this button to open the Set output directory dialog box. 

Set output directory Displays the directory path for the converted RINEX files. 

Overwrite files Select the overwrite options: Prompt for overwrite, Always 
overwrite, or Never overwrite. To select an overwrite option, click 
the arrow to the right of the field and select an overwrite option 
from the list presented.

GPS Check this box if the source data files contain GPS data. This 
option is on by default.
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2.  Click Input dir to open the Set input directory dialog box (Figure 7.9).      

3. Using standard Windows navigation procedure, navigate to the directory 
where the Ashtech files you wish to convert are stored. 

GLONASS Check this box if the source data files contain GLONASS data. 
This option is on by default. Do not check unless a GLONASS 
receiver was used to collect data.

Obs Check this box to create an observation file when converting to 
RINEX.

Nav Check this box to create a navigation file when converting to 
RINEX files.

Navg Check this box to create a GLONASS navigation file when 
converting to RINEX.

Met Check this box to create a meteorological file when converting to 
RINEX. If no meteorological data are available, the Met file is not 
created.

Free Space Displays the drive space available for the selected output 
directory.

Exit Closes RINEX Converter.

About Opens the About dialog box which displays the software version 
number.

Help Opens the on-line help system.

 Figure 7.9: Set Input Directory Dialog Box 

 Table 7.8: Ashtech to RINEX Tab Fields  (continued)

Item Description
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4. Click Save to accept the directory and close the Set Input Directory dialog 
box. 

The Input Directory lists the directory path, and Available Files lists the 
Ashtech files in the input directory (Figure 7.10).  

5. Select the file(s) you wish to convert to RINEX in the Available Files list. 

You can select multiple files by holding down the Ctrl key while selecting 
files.

After selecting a file(s) to convert, the B-File, E-File, S-File, OBS, NAV, 
NAVG, and MET fields, as applicable to the data in the file, populate with 
suggested file names. If you selected multiple files, the file names listed are 
associated with the last file selected. 

To avoid confusion, do not change the file names.

 Figure 7.10: Ashtech Files in Selected Ashtech Input Directory
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6. Click Output dir to open the Set output directory dialog box (Figure 7.11). 

7. Using standard Windows navigation procedures, navigate to the directory 
where you want to store the converted files. 

To avoid confusion, save the converted Ashtech files to a different directory than where the RINEX 
files are located. 

8. Click Save to accept the directory and return to the Set input directory 
dialog box.

The Output Directory field lists the directory path.

 Figure 7.11: Set Output Directory Dialog Box 
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9. Click Additional Info to open the Additional info for selected files dialog 
box to the OBS Tab (Figure 7.12).    

The information listed in these tabs are stored in RINEX files to give you 
reference information about the data. Although this additional information is 
optional, it provides a useful reference for future use.

10. Complete the fields in the OBS tab. The information entered in the OBS 
dialog is stored in the observation data file. Table 7.13: describes each field. 

[

 Figure 7.12: Additional Info for Selected Files Dialog Box- OBS Tab

 Table 7.13: Additional Info for Selected Files Dialog Box - OBS Tab

Field Description

STATION INFORMATION

Station Name Name of the survey point or station where data were collected.

Station Number Number of the survey point or station where data were collected.

Observer Name or code of the surveyor who collected the data.

AGENCY (Observing) Name of the company or agency who collected the data.

AGENCY (Creating Current File) Name of the company or agency who converted the data to RINEX.

Comments Any comments pertaining to the station, data quality, cover, GPS/
GLONASS, etc. 50-character length limit.
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11. Click Apply to save the changes made to the OBS tab.

You can enter information for all three tabs and save all the data using the Save button. The best 
practice however, is to save the data using the Apply button, for each tab immediately after entering 
the data in case of a computer or power failure.

The Save button saves the data entered on the active tab only, and closes the Additional info for 
Selected Files dialog.

RECEIVER INFORMATION

Receiver Serial # Serial number of the receiver that collected the data.

All Optional Headers Check this box if you want all non-mandatory fields to be filled in 
the RINEX file header.

ANTENNA INFORMATION

Offsets north (m) Horizontal distance, in meters, that the antenna is offset from the 
marker in the north/south direction. + is north, - is south.

Offsets East (m) Horizontal distance, in meters, that the antenna is offset from the 
marker in the east/west direction. + is east, - is west.

Delta Vertical (m) True vertical distance, in meters, between the bottom of antenna and 
the marker.

Radius (m) Radius of the antenna in meters.

Slant Distance (m) Measured distance, in meters, from the edge of the antenna to the 
marker. If a value for an antenna are entered, it overwrites the 
values in the S-file.

Type Type of antenna used in data collection.

Serial # Serial number of antenna used for data collection.

 Table 7.13: Additional Info for Selected Files Dialog Box - OBS Tab (continued)

Field Description
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12. Click Nav to switch to the Nav tab (Figure 7.14). 

13. Complete the fields in the NAV tab. The information entered in the NAV 
dialog is stored in the navigation data file. Table 7.15: describes each field.  

 Figure 7.14: Additional Info for Selected Files Dialog Box - NAV Tab

 Table 7.15: Additional Info for Selected Files Dialog Box - NAV Tab

Field Description

Agency (Creating Current File) Name of the company or agency who converted the data to 
RINEX.

Comments Any comments pertaining to the station, data quality, cover, 
GPS/GLONASS, etc. 50-characters maximum.
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14. Click Apply to save the changes made to the NAV tab, and click on the 
MET tab to switch to the MET tab (Figure 7.16).          

15. Complete the fields in the MET tab. The information entered in the MET 
dialog is stored in the meteorological data file. Table 7.17: describes each 
field.

 Figure 7.16: Additional Info for Selected Files Dialog Box - MET Tab

 Table 7.17: Additional Info for Selected Files Dialog Box - MET Tab

Field Description

Station Name Name of the survey point or station where data were collected.

Agency (Creating Current File) Name of the company or agency that converted the data to RINEX.

Comments Any comments pertaining to the station, data quality, cover, GPS/
GLONASS, etc. 50-character limit.

Meteorological Data List Date and time atmospheric data was collected (atmospheric pressure, 
temperature, relative humidity, and ZWET (Zenith Wet Tropospheric Delay).

Edit Click this button to open the Edit dialog box and edit the selected 
meteorological data line.
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16. Click Edit to open the Edit dialog box and inspect or change the 
meteorological data.

17. Enter the meteorological data, the date and the UTC time that the data was 
taken, and click OK. Table 7.19: describes the fields in the Edit dialog box.   
 

18. Click OK to accept the meteorological data and close the Edit dialog box.

 Figure 7.18: Edit Dialog Box

 Table 7.19:  Edit Dialog Box Parameters

Field Description

Date The year, month, and date that the data were recorded. D is the day of the month 
(not Julian day) the data was recorded.

Time The time the data were recorded. H is the hour of the day the data were recorded in 
UTC time (24 hour time scale) M is the minute of the hour the data were recorded in 
UTC time. S is the second of the minute the data were recorded in UTC time

Pressure (mbs) The recorded barometric pressure of the atmosphere in millibars.

Dry Temp (C) The recorded temperature of the air not corrected for humidity, in degrees Celsius.

Rel. Hum (%) The recorded relative humidity of the air in percent. 

ZWET (mm) Zenith Wet Tropospheric Delay—in millimeters (default = 0)
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19. Click Save to save the changes made to the Met tab and close the 
Additional info for selected files dialog box. 

• The Apply button saves any changes made to the active tab, and do
not close the Additional info for selected files dialog.

• The Save button saves any changes made any tab, and closes the 
Additional info for selected files dialog.

• Click Begin to convert the selected Ashtech files to RINEX format. Th
Conversion Status dialog box opens (Figure 7.20), indicating the statu
of the conversion process. Upon completion, the dialog indicates 10
for each file. Click Cancel to cancel the conversion to the current file 
type and proceed to the next file type.

• Click Cancel All to cancel the entire conversion.  

20. Click OK. 

RINEX Converter creates a *.log file in the directory containing all 
conversion activity. After restarting, RINEX converter overwrites the 
existing log file. To save the old log file, rename or move the file before 
restarting RINEX Converter. 

 Figure 7.20: Conversion Status Dialog 
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This appendix provides an overview of the various types of files used with the supported 
receivers, and the naming conventions for these files.

Names Convention

Post-processing packages, such as WinPRISM, Locus, or AOSS require data in a specific 
format using a specific file naming convention. Figure A.1 outlines the preferred and often 
required file name convention.

File names must not contain the following characters: spaces, tabs, commas (,), periods (.), 
equal signs (=), conditionals (< or >), question marks (?), colons (:), semicolons (;), 
asterisks (*), slashes (/ or \), the DOS pipe (|), quotation marks (“) or square brackets
]).

File names may contain the following characters: the letters A through Z, numbers 0
through 9, and the underscore (_). We recommend that file names be limited to thes
characters.

The following characters may be used in file names, but are not recommended: ‘ ' ~ 
$ % ^ & ( ) { } -.

 Figure A.1: File Naming Convention
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For example, the file name BBASEA97.059 indicates:

Types

Several types of files are used in conjunction with GPS receivers:

A-File Almanac data
B- File GPS measurement data
C-File Position data
D-File Descriptor data
E-File Ephemeris data
M-File Event marker data
S-File Site information)

A-File

Raw bit-packed binary almanac data broadcast from each satellite and recorded by the 
receiver. An almanac file is a list of all the satellites and their orbit parameters. This 
file can be used for predicting satellite position. Each satellite sends the almanac of 
every satellite, so if you lock onto one satellite, it indicates where all the other 
satellites are located. 

B-File

Raw data binary file containing carrier phase, code phase, and computed receiver 
position for every epoch, along with health flags indicating the confidence of the 
measurements. 

 Table A.1: Explanation of File Name BBASEA97.059

Parameter Description

B B-file type (raw GPS data)

BASE Site identification

A Session A - first recorded session

97 Year file recorded- 1997

059 Day of the year - day 059 corresponding to February 28
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C-File

ASCII file containing a chronological listing of time, site, number of satellites, and 
PDOP for every position. This file contains position information only, not carrier 
phase information.  

D-File

ASCII descriptor file containing feature and attribute data downloaded from the 
receiver. This file gives time in seconds of week (measured from midnight Saturday).  

E-File

Binary ephemeris file downloaded from a receiver. Unlike an almanac file, which 
gives information on all satellites, an ephemeris file applies only to the satellite which 
sent ephemeris data. The file is a record of the broadcast message comprising 
accurate orbit parameters and time corrections for all tracked satellites during the data 
recording period. This information is used for computing the satellite position. The 
ephemeris data are deciphered and configured into a readable structure.

M-File

ASCII file containing photogrammetry event marker time tag for each pulse coming 
through the photogrammetry input.   

S-File

ASCII file containing information entered by a field surveyor, including site 
information, receiver type, receiver version, and receiver channel version 
information.
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